Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/5/03</td>
<td>Documented Unconfirmed Pick Tickets Report window’s utility for Proof of Delivery.</td>
<td>33</td>
</tr>
<tr>
<td>2/25/03</td>
<td>PDAs must support Network HotSync.</td>
<td>4</td>
</tr>
<tr>
<td>4/2/03</td>
<td>Directions for downloading and applying PDA updates.</td>
<td>26</td>
</tr>
<tr>
<td>7/16/03</td>
<td>Changed official PalmOS support to 4.2.</td>
<td>4</td>
</tr>
<tr>
<td>8/27/03</td>
<td>Purge Order Entry List window documented.</td>
<td>49</td>
</tr>
<tr>
<td>10/9/03</td>
<td>Included where to find which PDAs do not support Network HotSync.</td>
<td>4</td>
</tr>
</tbody>
</table>
The documentation in this publication is provided pursuant to a Sales and Licensing Contract for the Prophet 21 System entered into by and between Prophet 21 and the Purchaser to whom this documentation is provided ("License Agreement"). In addition, the licensed software to which this documentation refers may be supported in accordance with a customer support agreement by and between the same parties ("Support Agreement"). All warranties, conditions of use, transfer restrictions, and other provisions in the License Agreement or Support Agreement which are applicable to Licensed Software, are applicable to this publication. In addition, this publication may include inadvertent technical inaccuracies or typographical errors for which Prophet 21 is not responsible. Changes may be periodically made to this publication; these changes will be incorporated in new editions of the publication. Any questions about the material contained in the publication should be addressed to the Prophet 21 Customer Support Department at http://customer.p21.com.

Nothing in this statement amends or extends the terms of your agreement with Prophet 21 including any warranties that may be included in our products. Warranties for such agreements are set forth in your agreement with Prophet 21.

Improvements and/or changes to the Licensed Software described in this publication may be made by Prophet 21 at any time without notice.
Table of Contents

1 PDA INTEGRATION OVERVIEW ............................................................................. 4
   Getting Started with PDA .................................................................................. 4

2 SOFTWARE INSTALLATION .................................................................................. 5
   PDA Integration Installations .............................................................................. 5
      Installation in a Fat Client Environment .......................................................... 11
      Installation in a Citrix MetaFrame Environment ............................................. 14
      Setting Up the Conduit’s Link to the CommerceCenter Database ................. 21
   Software Updates .............................................................................................. 26

3 PROOF OF DELIVERY ....................................................................................... 27
   CommerceCenter Integration Points ..................................................................... 27
   PDA Integration Points ...................................................................................... 36

4 PDA ORDER ENTRY ............................................................................................. 41
   CommerceCenter Integration Points ..................................................................... 41
   PDA Integration Points ...................................................................................... 51
1 PDA INTEGRATION
OVERVIEW

Prophet 21 CommerceCenter now integrates several features designed for use with a personal digital assistant (PDA) device, like a Palm Pilot.

GETTING STARTED WITH PDA

There are several tools you will need to install and use PDA functionality for CommerceCenter:

♦ PDA desktop software loaded on the PC from which you will synch the PDA (see PDA vendor documentation for instructions)
♦ A PDA with PalmOS version 4.2 or later
   Note: If you are using Citrix MetaFrame, ensure that your PDA supports Network HotSync. To see a list of PDAs that do not support Network HotSync, see solution 16713 on the www.palm.com support site.
♦ CommerceCenter 8.5, build 92 (CommerceCenter 9.5 for PDA Order Entry) or later must be installed from the local machine where you will synch PDA devices
♦ The CommerceCenter installation CD

Note: If you want to install the PDA desktop in a Citrix MetaFrame environment, you must use Add/Remove Programs in Windows and add the PDA desktop to the Citrix server; otherwise not all users will have access to the PDA desktop. See Installation in a Citrix MetaFrame Environment for more information.
To run any applications on the Personal Digital Assistant (PDA), you must set up your system and install the software onto the PDA. This chapter outlines how to set up your system, and the installation of the PDA software package for the fat client and Citrix MetaFrame environments.

PDA INTEGRATION INSTALLATIONS

The following series of sections will describe in detail how to set up CommerceCenter and your computer system for both Proof of Delivery and PDA Order Entry, download the PDA applications into the PDA, and install the integration portion of the code for PDA delivery and order entry functionality.

Setting Up CommerceCenter for Proof of Delivery

You must enable Proof of Delivery in the System Settings prior to installation. You must also set up a driver in Driver Maintenance, a link to where you want to store captured signatures, and the Scheduled Import Service Manager prior to performing the installation.

In order to use proof of delivery functionality, you must set up the system to accommodate it. The first step to doing that is to enable proof of delivery in CommerceCenter System Settings. In Order Processing folder of the System Settings, in the PDA node, select the Proof of Delivery Enabled option.
You also have to determine if you want to set proof of delivery to be for invoiced or uninvoiced pick tickets. These options will only be available after you have turned on the Proof of Delivery Enabled checkbox.

**Setting:**

**Description:**

**Invoiced Pick Tickets**

Only pick tickets that have been invoiced (already confirmed through shipping) will appear on delivery list that is created in Delivery List Maintenance.

**Un-invoiced Pick Tickets**

Only pick tickets that have not yet been invoiced (not yet confirmed through shipping) will appear on delivery list that is created in Delivery List Maintenance. When you import the delivery list information from the PDA after the delivery, the shipments will automatically confirm.

If you want to set up CommerceCenter to upload captured signatures, you must define a file path to which the captured signatures will be stored. You can do this on the Company tab in Company Maintenance.
Next you must set up a driver. Located on the System menu of the Order Processing module, the Driver Maintenance window allows you to create a driver, and maintain that driver's information. There are two ways to do this; you can either enter all the required information except for the Driver ID field on the Driver Form View tab, and save the record. The Driver ID will automatically be created, as will a contact ID for the driver.

The second method is to take an existing contact (one of your sales reps, an order taker, etc.) and give that person driver status in addition to any other positions they might hold within the system. This will allow that person to act as a driver in addition to their normal duties.

You must have this set up in CommerceCenter prior to installing the PDA applications. In addition, the driver ID should be the user ID for a user in the PDA. This is set up in the PDA desktop software. For specific instructions on how to do that, refer to your PDA documentation.

An explanation of any of the fields contained in this window can be obtained from the CommerceCenter Online Help topic Driver Maintenance.
Now you must set up CommerceCenter to automatically import the information the PDA uploads using the Scheduled Import Service Manager. The PDA will upload the shipment data as a flat file, and then the system will import it. You must set up the Scheduled Import Service Manager to Delivery Confirmation in the Scheduled Import Setup window, located on the Maintenance menu of the Imports/Exports module.

For more information about the Scheduled Import Service Manager and the Scheduled Import Setup, see the CommerceCenter online help.

**Note:** Make sure you do not have the default disposition in Customer Maintenance set to None. If you do, you will not be able to properly import undershipped orders.

### Scheduled Import Setup

<table>
<thead>
<tr>
<th>Type Of Import:</th>
<th>PDA Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Document Definition:</td>
<td></td>
</tr>
<tr>
<td>Transaction Set ID:</td>
<td>Delivery Confirmation</td>
</tr>
<tr>
<td>Source File Polling Path:</td>
<td>%3:\PDA</td>
</tr>
<tr>
<td>Transaction Summary File Path:</td>
<td>%3:\PDA\AFTER</td>
</tr>
<tr>
<td>Transaction Suspense File Path:</td>
<td>%3:\PDA\AFTER</td>
</tr>
<tr>
<td>Transaction Error File Path:</td>
<td>%3:\PDA\AFTER</td>
</tr>
<tr>
<td>Transaction Log File Path:</td>
<td>%3:\PDA\AFTER</td>
</tr>
</tbody>
</table>

*Active* Tab delimited File Format

<table>
<thead>
<tr>
<th>Import File Type Description</th>
<th>Import File Prefix Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery</td>
<td>PD</td>
</tr>
<tr>
<td>Delivery Stop</td>
<td>PS</td>
</tr>
<tr>
<td>Delivery Pick Ticket</td>
<td>OP T</td>
</tr>
<tr>
<td>Order Pick Ticket</td>
<td>OP T</td>
</tr>
<tr>
<td>Order Pick Ticket Detail</td>
<td>OP D</td>
</tr>
</tbody>
</table>

**Note:** The import file prefix codes you see above are examples only. You can set the values to whatever you want, provided that your files match them.

To set up the scheduled import, use the following instructions:

1. From the Type Of Import field, select **PDA Import**.
2. From the Transaction Set ID field, select **Delivery Confirmation**.
3. Set the file path where the Scheduled Import Service Manager will look for the PDA import files in the Source File Polling Path field. The path must already exist (i.e., the folders that will be monitored must be set up prior to setting up the scheduled import). This determines where the delivery files will be uploaded to from the PDA, and where they are available for processing by the Scheduled Import Service Manager.
Note: If you use more than one workstation to synch PDAs for delivery, or if you have a central server/workstation that runs the Scheduled Import Service Manager, you should set the path to a network share that all the workstations can access.

4. The remaining file paths store log files that result from the import of the flat files from the PDA. These should also be on a network share available to all the PDA workstations, and must already exist.

5. Be sure that the Active checkbox is enabled, so that the Scheduled Import Service Manager will run this task in the schedule. You should not change the Import File Prefix Code. If you do, delivery information will not upload.

Note: If you have the system using uninvoiced pick tickets, the shipment will be auto-confirmed when it is imported.

Setting Up CommerceCenter for PDA Order Entry

You must set up PDA Order Entry in CommerceCenter System Settings before you can use the PDA Order Entry functionality.

To set up PDA Order Entry in System Settings, go to the Order Processing folder in System Settings and select the PDA node. Check the Use PDA Order Entry checkbox to enable the PDA Order Entry fields in CommerceCenter.

Obtaining the Installation Program

Use the following instructions to find and run the installation program. Once you have run the program, skip to the sections below that match your environment, either fat client or MetaFrame.

If the CD autoruns:

1. Put your CommerceCenter CD into the client CD-ROM drive. The Prophet 21 CommerceCenter Setup window opens.
2. Select **Complementary Products**.

3. Select **Install PDA**.

4. Select the PDA integration (Proof of Delivery or Order Entry) that you would like to install on this client. The installation program for that application will start.

If the CD does not autorun:

1. Put your CommerceCenter CD into the client CD-ROM drive.

2. Open the CD.

3. Open the PDAIntegration folder

4. Double-click autorun.exe to begin the installation program.

5. Go to Step 1 in the section above for autorunning CDs.
INSTALLATION IN A FAT CLIENT ENVIRONMENT

The following sections detail installation for a fat client network environment. If CommerceCenter is not installed to the local machine, you must reinstall the network copy from the local machine to ensure that the proper registry settings are made. Although the graphics in the instructions are from the Proof of Delivery installation, these instructions apply to both PDA Order Entry and Proof of Delivery.

The PDA Installation Programs

After you have started the installation program, use the following instructions to complete the installation program.

1. The PDA Setup window appears. Click Next.

HTML Help does not have “native” ability to create annotations like WinHelp does; annotation functionality can be added via JavaScript since HTML Help is comprised of a series of HTML files compiled into a single .CHM file for delivery.
2. Click **I accept the terms in the license agreement**, then click **Yes**.

**Note:** If you are installing the Proof of Delivery integration program, skip this step.

3. You will then be prompted to select a folder to which you want to install a shortcut to the PDA installer. Select the path and click **Next**.

![PDA Proof of Delivery Setup](image)

4. You may see a message indicating that a DLL has been registered. Click **OK** each time the message occurs. It may occur two to three times.

5. Click **Finish** to exit the installation program. Your installation is now complete. If you are not installing a PDA application at this time, and you are using Proof of Delivery, continue to the section entitled **Setting Up the Conduit’s Link to the CommerceCenter Database**.

**Installing PDA Applications onto a PDA**

Use the following instructions to install the PDA applications onto a PDA.

**Important!** Any time that CommerceCenter and the PDA have to communicate information, the user name in the PDA desktop software must match the CommerceCenter driver ID for Proof of Delivery, or the CommerceCenter salesrep ID for PDA Order Entry.

1. Connect a PDA to the PC where the installation is taking place. See your PDA documentation for specific instructions on how to properly connect your PDA.
2. Change the user name in the PDA desktop software to match the CommerceCenter driver ID or salesrep ID you set up in the system.

3. Go to Start | Programs | Prophet 21 CommerceCenter (or whatever path in which you installed CommerceCenter) and select the PDA handheld application that you would like to install – Proof of Delivery or PDA OE.

4. The RDK Engine Installer window pops up. Select the user name of the PDA. The user name should be the driver ID/salesrep ID for the user. When you set up the PDA desktop application, you should have specified the user name as the driver ID/salesrep ID.

**Note:** Any time that CommerceCenter and the PDA have to communicate information, the user name in the PDA desktop software must match the CommerceCenter driver ID/salesrep ID.

5. Click **Install** to begin the installation.

6. You will get the Waiting for HotSync message. Press the HotSync button on your PDA to install the application. This process may vary from PDA to PDA. See your PDA documentation for more information.

7. If you will use Proof of Delivery from this client, go to the section on the link between the database and the PDA, entitled *Setting Up the Conduit’s Link to the CommerceCenter Database*, below.
INSTALLATION IN A CITRIX METAFRAME ENVIRONMENT

Important! If you are using Citrix MetaFrame, ensure that your PDA supports Network HotSync. To see a list of PDAs that do not support Network HotSync, see solution 16713 on the www.palm.com support site.

Use the following instructions to install the software necessary for proof of delivery PDA integration with CommerceCenter. Only one client session at a time may synch to the PDA from the MetaFrame server.

Note: You may see the following error message in one of three places:

1) When you start your Citrix client session
2) When you start the HotSync Manager
3) When you check the Network option (as specified in Step 1 on page 19)
This is the result of another user having the Network option checked in a Citrix client session. You will not be able to HotSync until that user turns off the Network option. Prophet 21 recommends that each user turn on the Network checkbox only when HotSyncing the PDA to resolve this issue.

Prophet 21 is addressing this issue in two steps:
1) First, a new more informative error dialog box is being created
2) The issue preventing multiple users from having the Network setting checked (and consequently, from HotSyncing at the same time) is being resolved.

Setting Up the Citrix MetaFrame Server

The following instructions will help you set up your Citrix MetaFrame server for PDA. All instructions below must be carried out on the MetaFrame server itself (i.e., not in a client session).

1. Install the PDA desktop software on the MetaFrame server. Do this by going into Control Panel on the server and using Add/Remove Programs to perform the installation. To do this:

   a. Double-click the icon for Add/Remove Programs.

   b. Click Install.

   c. Click Next. If the wizard does not find the program you want to install, it will offer a browse window.

   d. Browse to the PDA desktop software program you would like to add, and double-click it.

   e. Then, you should follow the instructions provided by your PDA manufacturer to install and configure the desktop software.
Note: If you do not use Add/Remove Programs, the desktop software will not be available to all users, and will not work properly.

2. Install CommerceCenter on your server. See the CommerceCenter Installation Guide for instructions on how to do this.

3. On the MetaFrame server, run the PDA integration setup program via Add/Remove Programs. After you start the installation program via Add/Remove Programs, follow the instructions in Steps 1-4 of the section The PDA Installation Programs (located on page 11). Then proceed to Step 4 below.

4. You must have RDK files installed on the Citrix server. To do this, go to the section Installing PDA Applications onto a PDA above on page 12 and follow Steps 1 – 3 only. When you get to Step 4, press Cancel to quit the installation as you will not be HotSyncing with a PDA from the server.

5. The HotSync Manager must be properly setup and running on the Citrix server. Right-click the HotSync taskbar icon on the Citrix server and selecting Setup from the right mouse button menu.

6. Click the Network tab and check all applicable user IDs. If an ID does not exist, create it in the PDA desktop application. Your PDA vendor provides instructions for this.
7. Also make sure the correct options are checked on the right mouse button menu. All the options should be unchecked.

8. Follow the instructions in the section below, *Setting Up the Conduit’s Link to the CommerceCenter Database*, to set up ODBC access to the CommerceCenter database if you are using the Proof of Delivery functionality. Set up the connection on the MetaFrame server.

**Setting Up Your PDA to HotSync When Using MetaFrame**

The instructions in this section allow you to configure your PDA device to hotsync if you use MetaFrame.

*Important!* If you are using Citrix MetaFrame, ensure that your PDA supports Network HotSync. To see a list of PDAs that do not support Network HotSync, see solution 16713 on the www.palm.com support site.

1. If you have an m100, you need to install the network hotsync application on the palm. This is an optional download for the m100. You can download this software from the following website: http://www.palm.com/support/downloads/netsync_legal.html.

2. If you are using Palms that have the net sync application preinstalled (PalmV, for example), follow the sub-steps indicated for PalmV here. If you use an m100, follow the sub-steps indicated for m100 here.
a. Go into the Palm’s HotSync application.

![PalmV HotSync](image1)

b. From the Options menu, select the **LANSync Prefs** option.

![PalmV Options](image2)

![m100 Options](image3)

c. Click the **LANSync** button, then **OK**.

![PalmV LANSync Preferences](image4)

![m100 LANSync Preferences](image5)
d. Open the Options menu again.

PalmV

m100

e. Select primary PC setup. Enter the name of the Citrix server in the Primary PC Name field. When you perform a network hotsync, the local Hotsync Manager will redirect the hotsync to the computer you enter here.

PalmV

m100
HotSyncing Your PDA Via Citrix MetaFrame Client Session

Important! If you are using Citrix MetaFrame, ensure that your PDA supports Network HotSync. To see a list of PDAs that do not support Network HotSync, see solution 16713 on the www.palm.com support site.

Note: You may see the following error message in one of three places:

1) When you start your Citrix client session
2) When you start the HotSync Manager
3) When you check the Network option (as specified in Step 1 below)

This is the result of another user having the Network option checked in a Citrix client session. You will not be able to HotSync until that user turns off the Network option. Prophet 21 recommends that each user turn on the Network checkbox only when HotSyncing the PDA to resolve this issue.

Prophet 21 is addressing this issue in two steps:
1) First, a new more informative error dialog box is being created
2) The issue preventing multiple users from having the Network setting checked (and consequently, from HotSyncing at the same time) is being resolved.

1. First make sure the correct options are checked on the right mouse button menu (right-click the HotSync Manager icon in your taskbar). Only the Network option is necessary. Make sure that you turn off the Network option when you have completed your HotSync.

2. Connect your PDA to the local client PC.

3. Change the user name in the PDA desktop software to the same as the CommerceCenter driver ID or salesrep ID. See your PDA documentation for instructions how to change the user name.
Note: **When using a new Palm:** Always perform a synch to the local PC before trying the network synch. This will establish a new user account in Palm Desktop on the local PC.

When performing a synch for the first time, the Palm Desktop HotSync Manager always prompts you if you want to add a new user. If you are synching with the local PC, you can click OK without any trouble. If you are synching with the Citrix server, you will have to log into the Citrix server session to click the OK button on this prompt. If your synch appears to hang, this is most likely the problem.

Ensure that you use Palm Desktop 4.0 or higher. You can download the most recent version here: [http://www.palm.com/support/downloads/](http://www.palm.com/support/downloads/)

4. From the Start | Programs menu, in the CommerceCenter sub menu in the Citrix session, select the PDA application that you want to install.

5. In the section entitled *Installing the PDA Applications onto the PDA* above, follow instructions 4 – 7.

If you do install the PDA desktop software on the client machine because you want to synch with the local machine, make certain that you shut that HotSync Manager down prior to synching via the MetaFrame session.
SETTING UP THE CONDUIT’S LINK TO THE COMMERCECENTER DATABASE

The following instructions allow you to set up a login to the database that the PDA feature will be able to use to download and upload data. Any instances where fat client setup is different from Citrix MetaFrame setup are noted.

**Note:** This process has been written step-by-step for Windows NT. The steps for Windows 2000 may look slightly different (depending on your Windows 2000 settings), but the process is the same.

1. From the Start/Settings menu, select **Control Panel**.

2. Select **Data Sources (ODBC)**. This will open the ODBC Data Source Administrator window.

![ODBC Data Source Administrator Window](image)
3. Go to the System DSN tab and click **Add**. This will open the Create New Data Source window.

4. Scroll to the bottom and select **SQL Server**.

5. Click **Finish**. This will open the Create a New Data Source to SQL Server dialog.

6. Enter a name and description for the data source.

**Note:** Record the name of the data source. You will need to enter this name later when you first download data to a PDA.
7. Enter the name of your production database server in the Server field and click **Next**. The following window opens:

**Note:** Prophet 21 recommends that the database server and the Citrix MetaFrame server be in the same domain.

8. Configure the window as appropriate for your database setup and click **Next**. The following window opens:
9. Select Change the default database to: and select the name of your production database. Click Next. The following window opens:

![Create a New Data Source to SQL Server](image)

10. Leave the defaults for this screen. Click Finish. This will open the ODBC Microsoft SQL Server Setup window.

![ODBC Microsoft SQL Server Setup](image)
11. Click **Test Data Source**.

12. You will get a screen like the following, indicating that the test was successful. If you do not get this message, consult your SQL documentation as to the nature of any errors displayed in the window. Click **OK** to close the window, and then click **OK** to close any other open windows. The data source has now been set up.
SOFTWARE UPDATES

Periodically, Prophet 21 releases an update for the PDA software. These updates can be found in the Downloads section on the Customer Web Site, in the 9.5 Application Updates and Information section. Use the following instructions to update your software.

1. Login to the Prophet 21 Customer Web Site.
2. Click Customer Support in the left navigation bar.
3. Click Downloads in the left navigation bar.
4. Click 95_Application_Updates_and_Information.
5. Click the PDA software update link. There are three available files: one for updating Proof of Delivery, one for updating PDA Order Entry, and a PDF containing the latest documentation for PDA.
6. Download the software you want to update.
7. Run the executable and unzip the files to the temp location on the PC where the application needs to be updated.
8. In the temp location, run the setup.exe file. If you already have PDA software installed, it will uninstall the old software the first time you run setup.exe, and you will have to run the setup.exe file again to install the update.
9. Install the PDA application onto the PDA again, as specified in the Installing PDA Applications onto a PDA section on page 12.
3 Proof of Delivery

Proof of delivery features allow you to carry a PDA with you when you go on a delivery route to customers. You can download pick ticket data from the CommerceCenter system and store it in the PDA, allowing you to confirm quantities delivered and store your route information. You can also use the PDA to capture an electronic signature from the receiver.

This feature is available for CommerceCenter 8.5 and later.

CommerceCenter Integration Points

The Proof of Delivery feature allows you to send your delivery personnel on their routes with a personal digital assistant (PDA), like a Palm Pilot, with delivery information stored in it. Delivery personnel will then be able carry a PDA device with them on shipping routes to capture customer signatures, and later upload them to CommerceCenter, along with shipping confirmations.

If you need information on how to set up Proof of Delivery functionality in CommerceCenter, see the installation sections.

Note: Any time that CommerceCenter and the PDA have to communicate information, the user name in the PDA desktop software must match the CommerceCenter driver ID.

Using a New PDA or Changing Users

If you have a new PDA and you need to install the PDA software on it, use the following instructions. See Installation in a Citrix MetaFrame Environment on page 14 to install the software in a Citrix MetaFrame Environment.

Important! Any time that CommerceCenter and the PDA have to communicate information, the user name in the PDA desktop software must match the CommerceCenter driver ID. See your PDA desktop software documentation for instructions on how to do that.

1. Change the user name in the PDA desktop application to the driver ID for the user under whose name you want to install the software.

2. Connect a PDA that already has the Palm OS installed to the PC where the installation is taking place. For specific instructions on how to install the OS or connect the PDA device, see the PDA documentation.
3. Go to Start | Programs | Prophet 21 CommerceCenter (if that is where you put the application when you installed it) and select **Install PDA Signature Capture Handheld Application**.

4. The RDK Engine Installer window pops up. Select the user name of the PDA. The user name should be the driver ID for the user.

**Note:** When you set up the PDA desktop application, you should have specified the user name as the driver ID.

5. Click **Install** to begin the installation.

6. You will get the Waiting for HotSync message. Press the HotSync button on your PDA to install the application.

**Important!** If a different driver is going to use the client workstation to download delivery lists after the first, then you must change the user name in the PDA desktop application to match the driver ID of the user.

**Adding Delivery Users in CommerceCenter**

If you need to add more delivery personnel in CommerceCenter, see page 7 under the Setting Up CommerceCenter section in the installation instructions.
Delivery List Maintenance

The Delivery List Maintenance window is used to create a list of pick tickets that will be shipped on a particular delivery.

Criteria Tab

The Criteria tab lists a number of parameters for the pick tickets, and you can set the ranges these parameters to determine what pick tickets will display when you are creating the delivery list on the Delivery Pick Ticket tab.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delivery No</strong></td>
<td>A system-generated number assigned to the delivery list when it is saved.</td>
</tr>
<tr>
<td><strong>Company ID</strong></td>
<td>The identifier of the company for which you are compiling a delivery list.</td>
</tr>
<tr>
<td><strong>Location ID</strong></td>
<td>The identifier of the location for which you are compiling a delivery list.</td>
</tr>
<tr>
<td><strong>List Option</strong></td>
<td>If this radio button is set to Shipping Route, the delivery list will be sorted by shipping route. If it is set to Ship To ID, the delivery list will be sorted by ship to ID.</td>
</tr>
<tr>
<td><strong>Shipping Route</strong></td>
<td>Categorizes deliveries for logistics management.</td>
</tr>
<tr>
<td><strong>Ship To ID</strong></td>
<td>Contains the range of ship to IDs for which orders will print on the delivery list.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>If this radio button is set to Picked Date, then the Date field on the delivery list will contain the pick date. If it is set to Required Date, then the Date field on the delivery list will contain the required date.</td>
</tr>
<tr>
<td><strong>Picked Date</strong></td>
<td>Contains the range of pick dates for which orders will print on the delivery list. Pick date is the date on which the pick ticket was printed.</td>
</tr>
<tr>
<td><strong>Required Date</strong></td>
<td>Contains a range of required dates for which orders will print on the delivery list.</td>
</tr>
</tbody>
</table>
Delivery Pick Ticket Tab

The Delivery Pick Ticket tab allows you to take a list of pick tickets compiled using the options from the Criteria tab and select which pick tickets to include in the delivery list that downloads onto the PDA device. This tab allows you to perform the actual download as well.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery No</td>
<td>A system-generated number assigned to the delivery list when it is saved.</td>
</tr>
<tr>
<td>Location</td>
<td>The location for which you are creating the delivery list.</td>
</tr>
<tr>
<td>Driver ID</td>
<td>The contact ID of the person who will be making the delivery.</td>
</tr>
<tr>
<td>Stop No</td>
<td>The number of the stop along the delivery. This can be changed by dragging and dropping the stop to the desired position.</td>
</tr>
<tr>
<td>Ship To ID</td>
<td>The ID for the address to which the delivery will be made for that stop number.</td>
</tr>
<tr>
<td>Ship To Name</td>
<td>The name of the ship to address within the system.</td>
</tr>
<tr>
<td>Route Code</td>
<td>The ID for the name of the route. This is used only for organizational purposes.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the pick ticket was printed.</td>
</tr>
<tr>
<td>Pick Ticket No</td>
<td>The number that identifies the pick ticket available for delivery. You can drill down into this field to get details on the pick ticket. This opens the Pick Ticket Detail tab.</td>
</tr>
<tr>
<td>Order No</td>
<td>The system-generated number that identifies the order associated with the pick ticket that is available for delivery.</td>
</tr>
<tr>
<td>Customer PO</td>
<td>The PO number that a customer gives you when they place their purchase order associated with the pick ticket that is available for delivery.</td>
</tr>
<tr>
<td>No of Lines</td>
<td>The number of lines on the pick ticket that is available for delivery.</td>
</tr>
<tr>
<td>Selected</td>
<td>Determines if a pick ticket will be included on a particular delivery. If the checkbox is enabled, then the pick ticket will be included. If the checkbox is not enabled, then the pick ticket will not be included on the delivery list.</td>
</tr>
</tbody>
</table>
Pick Ticket Detail Tab

The Pick Ticket Detail tab allows you to see detailed information about each pick ticket that is available for delivery.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Number</td>
<td>The system-generated number that identifies the order associated with the pick ticket that is available for delivery.</td>
</tr>
<tr>
<td>Company ID</td>
<td>The ID for the company in the system that created the pick ticket.</td>
</tr>
<tr>
<td>Location ID</td>
<td>The location where the pick ticket was printed.</td>
</tr>
<tr>
<td>Ship To ID</td>
<td>The ID for the location to which the order is shipping.</td>
</tr>
<tr>
<td>Order Date</td>
<td>The date on which the order was placed.</td>
</tr>
<tr>
<td>Requested Date</td>
<td>The date by which the order must arrive.</td>
</tr>
<tr>
<td>Customer ID</td>
<td>The ID in the system associated with the customer who placed the order.</td>
</tr>
<tr>
<td>PO Number</td>
<td>The purchase order number given by the customer when the order was placed.</td>
</tr>
<tr>
<td>Item ID</td>
<td>The ID of the items that have been picked.</td>
</tr>
<tr>
<td>Item Description</td>
<td>The description of each item that has been picked.</td>
</tr>
<tr>
<td>UOM</td>
<td>The unit of measure for each item that has been picked.</td>
</tr>
<tr>
<td>Qty Ordered</td>
<td>The quantity that the customer ordered of a particular item.</td>
</tr>
<tr>
<td>Qty Picked</td>
<td>The quantity of a particular item that was picked.</td>
</tr>
</tbody>
</table>
Creating a Delivery List

You create a delivery list from within CommerceCenter, and the list is then downloaded into the PDA device. If you are creating a delivery list in a Citrix MetaFrame environment, make certain that your session has the proper configuration. See *Installation in a Citrix MetaFrame Environment* above for more information.

**Note:** The first time you try to download a delivery list, the system will ask for the data source name (DSN). You must enter the same name you entered back in the Software Installation chapter, in the *Setting Up the Conduit’s Link to the CommerceCenter Database* section.

1. Open Order Processing.
2. Open Delivery List Maintenance from the Maintenance menu.
3. On the Criteria tab, enter the location ID from which you are making the delivery.
4. Select whatever ranges and filters you want to use to limit the search for pick tickets that will be made available for delivery on the Delivery Pick Ticket tab.
5. Apply the query by selecting *Retrieve* from the file menu. The Delivery Pick Ticket tab will open with the pick tickets available for the delivery listed.
6. All pick tickets default to Selected. Deselect the *Selected* checkbox for any pick tickets that you do not want to include in the delivery. Any pick ticket selected and downloaded will no longer be available if you run the query from the Criteria tab. To deselect all of the pick tickets, right-click and from the shortcut menu select *Deselect All*.
7. Enter the driver ID of the driver making the delivery in the Driver ID field.
8. Connect the PDA device to the serial port on your computer.
9. From the File menu, select *Save and Download*. The information will synch with the PDA, and the driver can take the PDA and make the delivery. Alternately, you can select *Save* to save the delivery list to download later. This is useful because each PDA can only hold one delivery list, so if you want to create several delivery lists at once, you can save them without downloading.

**Note:** When you perform the download, the PDA’s user ID and the PDA desktop software user ID must match the driver ID in CommerceCenter.

10. When the driver gets back, they can resynch the PDA by connecting it and bringing up the delivery number on the Criteria tab. Select *Upload* from the File menu to upload the data.

**Note:** It is not necessary for an order to have a status of Complete to upload.

There may be times that a driver cannot make a delivery (e.g., no one is there to receive the delivery, not enough time in the day, etc.). When you synch the PDA with CommerceCenter after making a delivery, the PDA sends delivery status information. The pick tickets for any stop that was not completed will be available for delivery again, so that another attempt can be made.
Confirming Shipment for Deliveries

The PDA will upload the shipment data as a flat file, and then the system will import it. After you upload the delivery information from the PDA and you want to import the pick ticket information for confirmation, run the Scheduled Import Service Manager, if it is not running constantly. If it is always running (as is the case where it is running on a dedicated workstation), then you do not have to worry about turning it on.

If you use uninvoiced pick tickets, your shipments of the deliveries will be auto-confirmed when you synch the PDA with CommerceCenter after the delivery has been completed, instead of manually confirming the shipments in Shipping. If you use invoiced pick tickets, the shipments were confirmed prior to the delivery list being created.

You can check to ensure that your pick tickets that need to be confirmed have been by running the Unconfirmed Pick Tickets report (located on the Reports menu in Order Processing).

Delivery Status Reports

There are three different delivery status reports: Delivery Status Report By Driver, Delivery Status Report By Delivery Number, and Delivery Status Report By Ship To ID. These reports are used to check on the status of deliveries, so you know if a delivery is open or closed, and you can see exactly what quantities were signed for and confirmed. The delivery data uploaded from the PDA updates these reports.

You can use delivery status reports in two cases, depending on if you use invoiced or uninvoiced pick tickets. If you use uninvoiced pick tickets, all quantities are automatically confirmed upon uploading the PDA. In this case, you would use the delivery status reports for informational purposes only.

If you use invoiced pick tickets, then shipment of your orders is confirmed prior to delivery. This means that you would use the reports to see if the quantities confirmed or signed for are different from the quantities slated for delivery. If they are, you will have to perform an RMA to credit the customer’s account.

Note: Users of Latitude Warehouse Management System automatically use invoiced pick tickets.

Delivery Status Report By Driver

The Delivery Status Report By Driver window allows you to enter the parameters by which you would like to print a delivery status report. The parameters available are company ID, location ID, driver ID, and delivery date.
The report will print deliveries in order of driver ID, and multiple deliveries for one driver ID will print in order of delivery number.

*Delivery Status Report By Ship To ID*

The Delivery Status Report By Ship To ID window allows you to enter the parameters by which you would like to print a delivery status report. The parameters available are company ID, location ID, ship to ID, and delivery date.

![Delivery Status Report By Ship To ID](image)

The report will print deliveries in order of ship to ID, and multiple deliveries for one ship to ID will print in order of delivery number.

*Delivery Status Report By Delivery Number*

The Delivery Status Report By Delivery Number window allows you to enter the parameters by which you would like to print a delivery status report. The parameters available are company ID, location ID, delivery number, and delivery date.

![Delivery Status Report By Delivery Number](image)

The report will print deliveries in the order of delivery number.
Viewing the Captured Signature

After the captured signature is uploaded, you can view it in CommerceCenter. You can view signatures if you go to the Shipments tab in:

♦ Order Entry
♦ Order Drill Down by Customer
♦ Order Drill Down by Item
♦ Order Drill Down by Order
♦ AR Drill Down by Customer
♦ AR Drill Down by Corporate ID
♦ AR Drill Down by Payment
♦ AR Drill Down by Invoice
♦ AR Drill Down by Amount

View the capture on the Shipments tab in these windows by right-clicking within the tab and selecting Proof of Delivery. If there is no signature associated with the order that your are drilling into, then a window will pop up with the Prophet 21 logo in it.

The signatures also print on invoices.

Using the PDA for Proof of Delivery

The PDA is used to provide the delivery order for the deliverer. It contains the pick tickets for all the orders that will be delivered to each ship to location, and the deliverer can edit quantities and use the PDA to capture the signature of the receiving party. For information on how to use the PDA software, see the PDA Integration Points, below.
PDA INTEGRATION POINTS

There is software on your PDA that allows you to use it to perform deliveries.

**Important!** If you are using Citrix MetaFrame, ensure that your PDA supports Network HotSync. To see a list of PDAs that do not support Network HotSync, see solution 16713 on the www.palm.com support site.

Getting Started on a Delivery

After you have synched the PDA with the necessary delivery information for your delivery route, you can access it from the PDA by going into the P21 icon.

Touch the P21 icon with the Pro21 label with the stylus, and you will see the opening screen of the proof of delivery application. The screen on the left is popped up briefly, and the screen on the right – the Driver Info window – is where you will end up.

**Field:** Delivery #  **Description:** Contains the CommerceCenter delivery number downloaded during the synch process.

**Field:** Status  **Description:** If this field is marked Open, then the delivery still has undelivered pick tickets on it.
**Driver**
Contains the CommerceCenter driver ID downloaded during the synch process.

**Date**
Contains the current date according to the PDA.

**OK**
Moves you to the next screen.

**About**
Provides the version and copyright information for the PDA software.

If you touch OK, the next screen will appear. This screen lists the stops for this delivery, in sequence:

<table>
<thead>
<tr>
<th>Field:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>The ship to location to which you are delivering.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the delivery. If it is open, then you have not completed the delivery, and if it is closed, you have completed the delivery.</td>
</tr>
<tr>
<td>Seq</td>
<td>Lists the sequence in which you have been set up to run the delivery route. This can be changed by dragging and dropping the companies.</td>
</tr>
<tr>
<td>Change Seq</td>
<td>Touching this will result in a reversal of the sequence of the stops. This is useful because the driver can use the PDA to load the truck, and then reverse the sequence to list the deliveries in the proper order.</td>
</tr>
</tbody>
</table>
At the Delivery Location

When you reach your first delivery location, touch on its stop. The next screen will open:

Field: Description:

Stop: Lists the delivery location that is displayed.

On Site checkbox: Determines if you have clocked in. If you have, it will be checked.

Tickets: Lists the pick ticket numbers that have been downloaded from CommerceCenter during synch for this delivery location. You can select a pick ticket and get detailed information about it, including customer PO number, order number, ship to ID, required date, pick date, and ship date. You can also preview the items on the pick ticket.

Instructions: Contains any delivery instructions downloaded from CommerceCenter during synch. To see the full set of instructions, touch the instruction. Touch Done to return to the previous screen.

Clock In: Opens a window that clocks you in, putting you on site. You must be clocked in to complete the delivery. If you have clocked in at a stop location, then the On Site checkbox will be enabled.

Delivery: Opens the Shipment Acceptance window. This enables you to record delivery results. See the below for more information.

Stop Notes: Opens the Stop Notes window for this delivery location. You can use this window to enter any notes that you might want to make about the shipment.
When you are ready to confirm the delivery in the PDA, make sure you are clocked in, and then touch the Delivery button. This opens the Shipment Acceptance window.

<table>
<thead>
<tr>
<th>Field:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tickets</strong></td>
<td>Contains a list of pick ticket numbers that are on the delivery for this location. If you touch a pick ticket number, a window will open displaying information for the line items of that order, including ticket notes. You can change quantities here by touching a line item, selecting Change, entering a new quantity, and determining if the material will be returned to stock (along with a reason code). If you reduce quantities here and select not to return the items to stock, you will have the option to select a reason code and disposition. If one is not specified, during the import, the system will use the default disposition from the customer record. <strong>Note:</strong> If the default disposition is set to None, the import will not work properly.</td>
</tr>
<tr>
<td><strong>Lines</strong></td>
<td>Contains the total number of lines on the pick ticket.</td>
</tr>
<tr>
<td><strong>Sig. Required</strong></td>
<td>If this checkbox is checked, then you must get a signature prior to completing the delivery confirmation process in the PDA.</td>
</tr>
<tr>
<td><strong>Accepted</strong></td>
<td>Accepts the above shipment list if enabled, including and changes to quantities.</td>
</tr>
<tr>
<td><strong>Rejected</strong></td>
<td>Rejects the above shipment list if enabled.</td>
</tr>
<tr>
<td>** Finish**</td>
<td>Confirms the acceptance or rejection of the shipment, and opens the Signature window.</td>
</tr>
</tbody>
</table>
When you select Finish, the Signature window opens. From there, you will complete the shipment. If you are capturing a signature, the recipient must sign in the empty box. The dot in the upper right corner of the box allows you to clear the screen, in case the recipient makes a mistake with their signature.

Field: 
Signature Required

Description: 
Determines if a signature is required for this order. If the box is checked, then you must capture a signature to complete the delivery in the PDA.

Recipient

Enter the name of the recipient who signs for the delivery.

Done

This will finish the current stop in the PDA. The PDA will open in the Stops window and the deliveries that have been completed up to that point will be marked Complete. You can use the Back button to go back to the Driver Info window.

After you finish the last stop and get back to your location, then you must upload the PDA.

Note: Make certain that you upload the PDA only if you have marked complete in the PDA all the stops you have completed.
4 PDA ORDER ENTRY

Personal Digital Assistant (PDA) Order Entry features allow you to create a list of items for a set of ship tos and download them to a PDA so that you can take orders on the PDA when you are at a customer site, and then upload them into the system when you are done.

This feature is available only on CommerceCenter 9.5 and later.

COMMERCECENTER INTEGRATION POINTS

Using a New PDA or Changing Users

If you have a new PDA and you need to install the PDA software on it, use the following instructions. See Installation in a Citrix MetaFrame Environment on page 14 to install the software in a Citrix MetaFrame Environment.

Important! Any time that CommerceCenter and the PDA have to communicate order information, the user name in the PDA desktop software must match the CommerceCenter salesrep ID. See your PDA desktop software documentation for instructions on how to do that.

1. Change the user name in the PDA desktop application to the salesrep ID for the user under whose name you want to install the software.

2. Connect a PDA that already has the Palm OS installed to the PC where the installation is taking place. For specific instructions on how to install the OS or connect the PDA device, see the PDA documentation.
3. Go to Start | Programs | Prophet 21 CommerceCenter (if that is where you put the application when you installed it) and select **Install PDA OE Handheld Application**.

4. The RDK Engine Installer window pops up. Select the user name of the PDA. The user name should be the salesrep ID for the user.

**Note:** When you set up the PDA desktop application, you should have specified the user name as the salesrep ID.

5. Click **Install** to begin the installation.

6. You will get the Waiting for HotSync message. Press the HotSync button on your PDA to install the application.

**Important!** If a different salesrep is going to use the client workstation to download order entry lists after the first, then you must change the user name in the PDA desktop application to match the salesrep ID of the user.

**Setting Up Criteria for the OE List**

You will be able to download select items to your PDA for the purposes of ordering. Since the PDA’s memory is limited, you will want to download as few items as possible – for example, only your top 20 items, rather than all of your items, especially if you are visiting several customers at once.
The PDA OE List Maintenance window allows you to set up the criteria by which items get downloaded for this ship to. The Query tab allows you to query criteria IDs and make changes to groups of IDs at once. The Form View tab contains all the fields for just one OE list criteria, and enables you to create and edit list criteria.

### Field: Criteria ID

**Description:**

The ID the system uses to track the criteria you enter on this tab. After you enter the criteria you want and save the record, you can retrieve criteria at any time by using this ID. You will also specify this ID on the OE Options tab in Ship To Maintenance (see Setting Up Ship Tos for PDA Order Entry, page ). This ID must be unique; no two criteria IDs can be the same.

Criteria IDs are assigned to ship tos, determining what items download for the ship to.

### Field: Description

**Description:** A brief description that helps you identify your criteria ID.
**Items**

Contains options that determine precisely which items will be downloaded to the PDA. They are as follows:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Items At Location</strong></td>
<td>All the items at the location will be downloaded onto your PDA. If this option is selected, the Top X Items option and the Use Additional Criteria option are unavailable. <strong>Note!</strong> Your PDA is limited in the amount of memory it has available for this list, depending on what you are using it for – you may not always be able to download all the items at your location onto the PDA.</td>
</tr>
<tr>
<td><strong>Top X Items</strong></td>
<td>Since you may not be able to download all items at a location onto your PDA, you may want to just download the ten or twenty that you sell the most often to a particular ship to. This option allows you to do that, and it uses the invoiced items or invoiced lines for a particular ship to, as well as selecting the amount of time that will be considered. The following four options are sub-options of Top X Items.</td>
</tr>
<tr>
<td><strong>Pieces Sold</strong></td>
<td>The top items will be determined by the number of pieces invoiced.</td>
</tr>
<tr>
<td><strong>Order Lines</strong></td>
<td>The top items will be determined by the number of lines ordered.</td>
</tr>
<tr>
<td><strong>Number of Items Per Ship To</strong></td>
<td>Determines how many items to include in the download.</td>
</tr>
<tr>
<td><strong>Invoice Days Last</strong></td>
<td>Determines the number of days within which the system will calculate the number of pieces or lines of an item sold.</td>
</tr>
<tr>
<td><strong>Use Addition Criteria</strong></td>
<td>If you want to further refine your filter for the items that will download onto the PDA, place a check in this checkbox. That will make the following three fields available.</td>
</tr>
<tr>
<td><strong>Supplier ID and To</strong></td>
<td>The range of supplier IDs by which the download will be limited.</td>
</tr>
<tr>
<td><strong>Product Group ID and To</strong></td>
<td>The range of product group IDs by which the download will be limited.</td>
</tr>
<tr>
<td><strong>Item ID and To</strong></td>
<td>The range of item IDs by which the download will be limited.</td>
</tr>
</tbody>
</table>

To create a criteria ID, simply fill in the appropriate information and save the record. The criteria ID will then be available in Ship To Maintenance.
Note: The system has one criteria ID hard-coded into it. This is called “ALL” and it downloads all the items in the location.

Continue on to Setting Up Ship Tos for PDA Order Entry to assign a criteria ID to a ship to.

Setting Up Ship Tos for PDA Order Entry

To be able to download items from a ship to onto the PDA, you must have PDA Order Entry activated in Ship To Maintenance. Use the following instructions to activate PDA Order Entry in Ship To Maintenance:

1. In the Order Processing module, from the Maintenance menu, select Ship To Maintenance.
2. Focus on the OE Options tab.

3. The OE Options tab contains two new options: PDA Order Entry and Criteria ID. Check PDA Order Entry to activate the Criteria ID field. Enter the criteria ID that you want to use. For more information on criteria IDs, see the section Setting Up Criteria for the OE List above.

The ship to is now ready to have items downloaded to a PDA so that you can use the PDA to enter orders. A ship to will only be retrieved if the OE list criteria specify the primary salesrep for the ship to.

Creating an Order Entry List

Before you can download the list of items and ship tos onto your PDA for all the ship tos you are going to visit, you must create the list of items. The PDA OE List Maintenance window allows you to create the list of items and ship tos.
**Field:** Description:

**List ID**
The ID that identifies the criteria listed on the Criteria tab in PDA OE List Maintenance in the system. The criteria is saved under this ID when you click the Save icon. The blank unlabeled field to the right of the List ID field contains a description of the list.

**Company ID**
The company ID for which the list will be generated.

**Location ID**
The location ID for which the list will be generated. All items in the order entry list will be sellable at this location, regardless of all other settings.

**Salesrep ID**
The salesrep for which the order entry list will be created. The salesrep must be the primary salesrep for the ship to for the ship to to appear on this list.

**List Date**
The date on which the order entry list was downloaded to the PDA.

After you populate the fields on tab with the desired information, the Ship to List, Item Criteria, and Additional Items tabs become available. The following sections describe each tab and the role it plays in creating an order entry list.

The Ship To List tab displays ship to information for each ship to that can be a part of the list, as well as the ability to select precisely which ship tos are included in the list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship To ID</td>
<td>The ID for the ship to that is available for download onto the PDA.</td>
</tr>
<tr>
<td>Ship To Name</td>
<td>The name for the ship to that is available for download onto the PDA.</td>
</tr>
<tr>
<td>Address 1, City, State, Zip Code</td>
<td>The street address, city, state, and zip code for the ship to.</td>
</tr>
<tr>
<td>Customer ID</td>
<td>The customer ID that is associated with that ship to.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>The customer name that is associated with that ship to.</td>
</tr>
</tbody>
</table>
**Selected checkbox**

Determines if the ship to will be included in the order entry list. You can check the checkbox by clicking it, or by right-clicking and selecting Select, Deselect, Select All, or Deselect All.

The Item Criteria tab in this window is identical to the *Setting Up Criteria for the OE List* section on page 43 above. It allows you to change your item list generation criteria prior to generating your list.

If you press the Retrieve button (or select Retrieve from the File menu), CommerceCenter will generate your list of items to download. It will price the items according to your customer or item pricing during the list generation. You can select or deselect items for the list clicking the Selected checkbox, or by right-clicking on an item and choosing Select, Select All, Deselect, or Deselect All.

### PDA OE List Maintenance

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Ship To List</th>
<th>Item Criteria</th>
<th>Item List</th>
<th>Additional Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company ID:</td>
<td>TOOL</td>
<td>The Tool Trade</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location ID:</td>
<td>102131</td>
<td>Central Warehouse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ship To ID:</td>
<td>102176</td>
<td>SFS Internation Contractors</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Item Description</th>
<th>UOM</th>
<th>Price</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLIPPERS</td>
<td>3/4&quot; Steel Clippers</td>
<td>EA</td>
<td>5.950</td>
<td>✔</td>
</tr>
<tr>
<td>DRILL121</td>
<td>1/2&quot; 24V Cordless Drill</td>
<td>EACH</td>
<td>150.1060</td>
<td>✔</td>
</tr>
<tr>
<td>DRILL381</td>
<td>3/8&quot; Makita 12V Cordless Drill</td>
<td>EACH</td>
<td>111.8888</td>
<td>✔</td>
</tr>
<tr>
<td>DRILL381B</td>
<td>Drill 3/8&quot; w/ 2 9.6V batteries.</td>
<td>EACH</td>
<td>87.9534</td>
<td>✔</td>
</tr>
<tr>
<td>DRILLBIT</td>
<td>Makita 28pc Drill Bit Set</td>
<td>EA</td>
<td>22.3800</td>
<td>✔</td>
</tr>
<tr>
<td>DRILLKIT</td>
<td>3/8&quot; Drill and Drill Bit Set</td>
<td>EA</td>
<td>167.8500</td>
<td>✔</td>
</tr>
<tr>
<td>DRIVER SET</td>
<td>6 pc Screwdriver Set</td>
<td>EA</td>
<td>8.8520</td>
<td>✔</td>
</tr>
</tbody>
</table>

**Note:** The following table includes only fields that have not been described in the tables above.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item ID</strong></td>
<td>The ID for an item that is available to be a part of the order list.</td>
</tr>
<tr>
<td><strong>Item Description</strong></td>
<td>The description for an item that is available to be a part of the order list.</td>
</tr>
<tr>
<td><strong>UOM</strong></td>
<td>The unit of measure for the item.</td>
</tr>
<tr>
<td><strong>Price</strong></td>
<td>The price of the item that was calculated during the generation of the list.</td>
</tr>
<tr>
<td><strong>Selected checkbox</strong></td>
<td>Determines if the item will be downloaded into the PDA during synch.</td>
</tr>
</tbody>
</table>
The Additional Items tab allows you to add items to the download by entering the item information. You need the same information that is provided for items on the system-generated order list.

**Download the List to Your PDA**

After you have decided all the items that will be included in the list for download, you can download the items. To download the items, go to the File menu and select Save and Download.

The system will prompt you to press the hotsync button on your PDA. After you press the button, the item information will be downloaded onto your PDA.

**Note:** After you have downloaded the list, you may see in the PDA that you have more items than just your top 15, etc. This is because the list includes all customer part numbers for that customer for that item as well as the item IDs.

**Uploading the List from Your PDA**

After you have returned from your customers, you must upload the orders from the PDA onto your CommerceCenter system. This is accomplished in the PDA OE List Maintenance window. From the File menu in that window, select Upload, and then press your HotSync button. The list will be uploaded and automatically imported to create sales orders in the same way that quotes are converted to orders. If there is an
error, you can view the suspense files in the Edit Import Suspense Files in the Imports/Exports module and correct the errors.

Note: You must re-hotsync your PDA after you have completed an upload to clear the PDA’s memory of the orders you have entered; do not repeat the upload procedure, just press the Hotsync button on your PDA. If you do not, you will duplicate your orders next time you upload.

**Purging Your Unused Order Entry Lists**

You can permanently delete obsolete or unused order entry lists from your CommerceCenter database using the Purge Order Entry List window. You can find the window in the Order Processing module, in the System menu. The window has two tabs: Criteria, and Purge List.

The Criteria tab allows you to create a set of criteria that determines which order entry lists will be available on the Purge List tab for deletion. This tab can help you narrow the range of possible lists so that it is easier to find the list or lists that you want to delete.

<table>
<thead>
<tr>
<th>Field:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company ID</td>
<td>The company for which you want to delete order entry lists.</td>
</tr>
<tr>
<td>Location ID and To</td>
<td>Allow you to set up a range of location IDs, or you can include all location IDs by default.</td>
</tr>
</tbody>
</table>
**Salesrep ID and To**  
Allow you to set up a range of salesrep IDs, or you can include all salesrep IDs by default.

**OE List Date and To**  
Allow you to set up a range of dates on which OE lists were generated, or you can include all possible dates by default.

To generate a range of order entry lists, create your criteria and select **Retrieve** on the File menu.

The Purge List tab allows you to permanently delete order entry lists. You can delete lists by checking the checkbox in the Delete column and saving the record.

<table>
<thead>
<tr>
<th>List ID</th>
<th>Company ID</th>
<th>Location ID</th>
<th>Salesrep ID</th>
<th>List Date</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>LST1</td>
<td>TOOL</td>
<td>102131</td>
<td>100335</td>
<td>11/11/02</td>
<td></td>
</tr>
<tr>
<td>TC1</td>
<td>TOOL</td>
<td>102131</td>
<td>100335</td>
<td>10/31/02</td>
<td></td>
</tr>
</tbody>
</table>

**Field:**  
**Description:**

- **List ID**: Displays the ID for the list you can delete.
- **Company ID**: Displays the ID for the company in which the list exists.
- **Location ID**: Displays the location ID for the location in which the list exists.
- **Salesrep ID**: Displays the salesrep ID associated with the list.
- **List Date**: Displays the date on which the list was generated.
- **Delete**: Allows you to determine if the list will be deleted when you save the record.
PDA INTEGRATION POINTS

There is software on your PDA that allows you to enter orders on it to be uploaded into the CommerceCenter system later. The PDA Integration Points section deals specifically how to enter an order on your Personal Digital Assistant device.

Important! If you are using Citrix MetaFrame, ensure that your PDA supports Network HotSync. To see a list of PDAs that do not support Network HotSync, see solution 16713 on the www.palm.com support site.

Getting Started with the PDA Order Entry Functionality

This section will detail how to navigate to the beginning of the PDA Order Entry application on your PDA.

After you have synched the PDA with the necessary ship-to and item information, you are ready to enter orders in your PDA. In the home screen of the PDA, you will see a P21 icon with “POE” underneath it. It will be in the All or Unfiled section of your PDA home screen (the home screen is the screen you arrive at when you press the house on your PDA pad). Ensure that you do not mistake the icon for the proof of delivery application, which has “Pro21” underneath its icon.
Touch the POE icon. The PDA Order Entry application opens to its initial window.

![PDA Order Entry Interface]

**Field:**

**Description:**

- **Company**
  - Displays the company ID and company name from which you have generated a sales list.

- **Location**
  - Displays the location ID and location name for which the salesrep will enter orders.

- **Sales Rep**
  - Displays the salesrep ID and salesrep name who is entering the orders.

- **List Date**
  - Displays the date on which the sales list was downloaded.

- **Enter Order**
  - Opens the Ship To Selection window, the first step in entering an order.

- **Review Orders**
  - Opens a window that allows you to review orders that have already been entered since the last upload. See page 61 for more information.

- **About**
  - Opens the About window which lists Prophet 21’s contact information, as well as the version of the PDA application.

To begin entering an order, continue to *Entering an Order on the PDA.*
Entering an Order on the PDA

To enter an order, you must press the Enter Order button on the initial opening screen of the PDA order entry application. This will open the Ship To Selection screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>102143</td>
<td>102143 is not a field name; it is data in the field. This field that 102143 occupies in the graphic above is the ship to ID.</td>
</tr>
<tr>
<td>ServiStar Hardware</td>
<td>ServiStar Hardware is not a field; it is data in the field. This field that ServiStar Hardware occupies in the graphic above is the ship to name.</td>
</tr>
<tr>
<td>Home</td>
<td>Allows you to return to the initial home window of the application.</td>
</tr>
</tbody>
</table>
Select the ship to for which you would like to enter an order. This opens the Ship To Info screen.

**Ship-To Info**

**Ship-to:** 102143  
**ServiStar Hardware**  
**Address:** 123 Main St  
Harrisburg  
PA 18562  

**Avail credit:** 0.00  

[Back] [Enter Order]

**Field:**  
**Ship To**  
**Address**  
**Avail Credit**  
**Back**  
**Enter Order**  

**Description:**  
**Ship To**  
Displays the ship to ID and ship to name for which you are entering an order.  

**Address**  
Allows you to enter or edit the ship to address. If you edit the ship to address, it will upload into CommerceCenter and populate in the Ship To tab in Order Entry.  

**Avail Credit**  
Displays the credit available to the customer.  

**Back**  
Takes you back to the Ship To Selection screen.  

**Enter Order**  
Opens the Order Header screen.
Edit any necessary address details, and touch Enter Order to open the Order Header screen.

![Order Header Screen]

**Field:**

**Description:**

- **Ord #**
  - The sequential number in which the current order was entered on the PDA.

- **Quote**
  - Determines if the order is imported into CommerceCenter as a quote. If it is checked, the order is imported as a quote; if it is unchecked, then the order is imported normally. This checkbox defaults to unchecked.

- **Ship To**
  - Displays the ship to ID and ship to name for which you are entering an order. If you touch the “(i)” button (a letter i that has a circle around it), the Ship To Info screen opens, allowing you to edit your ship to address or view available credit. Touch Back to return to the Order Header screen.
Opens the Ship To Info screen, allowing you to edit your ship to address and view available credit information. Touch the Back option to return to the Order Header screen.

**Cust PO**
Allows you to enter a customer PO if one is available. If the customer PO number is required for a customer in CommerceCenter, then it is required in the PDA functionality as well, and you must enter a customer PO number to continue to enter the order.

**Ord Date**
The date on which the order is entered; this field is editable.

**Req Date**
The date on which the order is required. Defaults to current date, but it can be edited to any date in the future. You cannot enter a date that has passed.

**Notes & Delivery Instructions**
Opens the Notes & Delivery Instructions screen. This screen allows you to enter order header notes and delivery instructions. Touch Back to return to the Order Header screen.

**Cancel**
Cancels the order in progress and returns you to the initial screen of the PDA application.

**Add Item**
Opens the Item Selection screen, allowing you to enter items.
After you have edited the customer PO number, dates, and notes as desired on the Order Header screen, continue to the Item Selection screen by touching the Add Item button.

**Item Selection**

![Item Selection Screen](image)

**Field:**  
**Description:**

**Item List Box**  
The item list box contains a list of items (either item ID or item description, depending on the setting of the Desc option – see below) that have been included in the PDA application for that ship to during synch. The options displaying on the graphic above are DRILL121 and HANDLING. If you have more items than will fit in the item list box, then an arrow will appear at the bottom right corner of the screen, allowing you to scroll through the options.

**Note:**  
After you have downloaded the list, you may see in the PDA that you have more items than just your top 15, etc. This is because the list includes all customer part numbers for that customer for that item as well as the item IDs.

When you touch an item listed here, the Order Line-Item screen opens.

**Search**  
Allows you to search for an item by entering the first few characters in the item ID. For example, if you put in the letters DRI, the PDA will take you to the first “DRI” in the list (or the closest thing to it).

**Desc/ItemID**  
Toggles the screen between a view of item IDs and item descriptions in the item list box. If the box is currently set to item ID, the word “Desc” will display on the screen; if the box is set to item description, then the word “ItemID” will display on the screen.

**Back**  
Returns you to the Order Header screen.
Summary

The Summary option only appears after you have selected an item and touched either Next Item or Cancel on the Order Line-Item screen.

This option allows you to view the Order Summary screen, allowing you to see a summary of the order, including totals. In addition, you can accept the order, or go back and add items, or change header information, etc. For more information, see page 60.

When you select the item you want, the Order Line-Item screen will open.

Field: Description:

Ord #  The sequential number in which the current order was entered on the PDA.
Ship To  Displays the ship to ID for which you are entering an order.
Item     Displays the item ID and item description for this line item.
Opens the Item Info screen, which allows you to supplier ID, product group, availability (as of the time the information was downloaded to PDA), and sales unit price per break level. The Back option allows you to return to the Order Line-Item screen.

<table>
<thead>
<tr>
<th>Item Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item ID: DRILL121</td>
</tr>
<tr>
<td>Supplier ID: 1005183</td>
</tr>
<tr>
<td>Prod group: FAST</td>
</tr>
<tr>
<td>Avail: 99,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sales ut price</th>
<th>Sales ut qty break</th>
</tr>
</thead>
<tbody>
<tr>
<td>150.1060</td>
<td>15.0000</td>
</tr>
<tr>
<td>150.1060</td>
<td>30.0000</td>
</tr>
<tr>
<td>150.1060</td>
<td>50.0000</td>
</tr>
<tr>
<td>150.1060</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

**Req Date**
The date on which the line item is required. Defaults to current date, but it can be edited to any date in the future. You cannot enter a date that has passed.

**Qty**
The quantity to order of the specified line item.

**Ut**
Displays the sales UOM (Unit Of Measure) ID, as well as the number of units that are contained within that ID.

**Ut Price**
Displays the sales unit price, as determined by pricing schedules, etc., at the time that the item list information was downloaded to the PDA.

**Ext Price**
Displays the extended price for the line – this is equal to Ut Price x Qty (or unit price multiplied by quantity ordered).

**Price Edit**
Indicates if the price has been edited during the order entry process. If the checkbox is checked, the price has been altered. If it is unchecked, the price has not been altered.

**Notes**
Opens the Notes screen. This allows you to enter order line notes. The Back option returns you to the Order Line-Item screen.
**Cancel**
Cancels the line item from the order and returns you to the Item Selection screen.

**Next Item**
Confirms the entered item and returns you to the Item Selection screen to select a new item for the order.

**Summary**
Opens the Order Summary screen.

After you select all the options you want in the Order Line-Item screen, touch the Summary option. When you select the Summary option, the Order Summary screen opens.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ord #</td>
<td>The sequential number in which the current order was entered on the PDA.</td>
</tr>
<tr>
<td>Ship To</td>
<td>Displays the ship to ID for the order.</td>
</tr>
<tr>
<td>Items</td>
<td>Displays the number of line items on the order.</td>
</tr>
<tr>
<td>Total</td>
<td>Displays the total price of all the line item quantities on the order.</td>
</tr>
<tr>
<td>Item List Box</td>
<td>Displays the item ID and quantity ordered for each line item on the order.</td>
</tr>
<tr>
<td>Header</td>
<td>Allows you to return to the Order Header screen and edit any header information on the order that you choose.</td>
</tr>
<tr>
<td>Add Item</td>
<td>Allows you to add an additional line item to the order.</td>
</tr>
<tr>
<td>Cancel Order</td>
<td>Cancels the entire order, and returns you to the initial application screen.</td>
</tr>
</tbody>
</table>
Accept Order

Accepts the order, and returns you to the initial application screen.

Viewing an Existing Order

You can view an order that has already been entered into the PDA. To do this, touch the Review Orders option on the initial screen of the application. The Order Select screen appears.

<table>
<thead>
<tr>
<th>Field:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Column</td>
<td>Displays the sequential number in which the current order was entered on the PDA.</td>
</tr>
<tr>
<td>Middle Column</td>
<td>Displays the ship to name assigned to that order.</td>
</tr>
<tr>
<td>Right Column</td>
<td>Displays the date on which the order was entered.</td>
</tr>
<tr>
<td>Home</td>
<td>Returns you to the initial application screen.</td>
</tr>
</tbody>
</table>

If you touch a row for a particular order on any column, you will open the Order Summary screen for that order. You can perform all the function that you can in the Order Summary screen (see page 60 above), and when you exit the Order Summary screen, you will return to the Order Selection screen.
Index

C
changing users, 27, 41
confirming shipments, 33

D
database, linking to CommerceCenter, 21
Delivery List Maintenance, 29
delivery list, creating, 32
delivery status reports, 33
Driver Maintenance, 7

I
installation files, where to obtain, 9
installation, Citrix MetaFrame, 14, 16, 19, 36, 51

P
PDA desktop software, 4
PDA installation, 11

S
Scheduled Import Service Manager, 8
setting up a driver, 7
setting up the Scheduled Import Service Manager, 8
signature, viewing the capture, 35
starting a delivery, 36
System requirements, 4

U
using a new PDA, 27